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About this guide 
This document describes the features and functionality of SG-System II Console. Before you 
begin using SG-System II Console, be sure to read this guide for installation instructions and 
other important information. This guide contains instructions for: 
• Installing SG-System II Console on your computer 
• Configuring and connecting SG-System II units 
• Programming SG-System II units 
• Setting up and viewing log files 
 
 
System requirements 
The SG-SYSTEM II Console is compatible with: 
• Microsoft Windows 2000 Professional, SP 4 
• Microsoft Windows 2000 Server, SP 4 
• Microsoft Windows 2003 Server, SP 1 
• Microsoft Windows XP Professional, SP 2  
 
Base requirements of the computer are determined by the operating system selected.   
 
Additional requirements are: 
• NIC for TCP/IP Ethernet connection 
• USB 1.1 for USB connection 
 
About SG-System II Console 
SG-System II Console provides a graphic user interface to communicate with the SG-System II to 
set options, update firmware, view status and capture printer logs. Each installation of SG-System 
II Console can support up to four SG-System II units connected through USB or TCP/IP.  
 
The SG-System II units work independently of SG-System II Console and therefore do not have 
to be connected to the computer to work. 
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Installing SG-System II Console 
This section describes how to install SG-System II Console. To install SG-System II Console you 
must be logged into the computer as an Administrator.  
 
Note: If you are planning to run the SG-System II Console under a Windows Limited User 
account (i.e. non-Administrator), you must ensure: 
• The SG-System II Console is installed to the Program Files folder (the default), and the user’s 

Windows account has Read, Write, and Execute permissions to that folder, or; 
• The SG-System II Console is installed to a common folder outside of Program Files. 
• The Windows Limited User must be the first user to run SG-System II Console. If a Windows 

Administrator runs it first, then Limited Users (non-administrators) will not be able to modify 
the Console's configuration. 

 
Note: This document will refer to the program folder as C:\...\Sur-Gard\SG-System II Console\ 
where … indicates the path you have selected.  
 
Note: Document the location of the SG-System II Console files for other users. 
 
1. Insert the SG-System II Console installation disk in the computer’s CD or DVD drive. 
2. To view the contents of SG-System II Console installation CD, open the drive folder. 
3. Open the Install folder, and then double-click setup.exe. 
4. On the Welcome to the InstallShield Wizard for SG-System II Console screen, click Next. 
5. On the License Agreement screen, read the end-user license agreement, and then click the 

option I accept the terms in the license agreement. 
6. Click Next. 
7. On the Customer Information screen, in the User Name box, type your name. 
8. In the Organization box, type the name of our organization. 
9. To install SG-System II Console for all users, click Anyone who uses this computer (all 

users) or, to install the program for your use only, click Only for me. 
10. Click Next. 
11. To select a folder to install SG-System II Console and save its related files, on the 

Destination Folder screen, click Change. 
12. On the Change Current Destination Folder screen locate and select a folder, and then click 

OK. 
13. Click Next. 
14. On the Ready to Install the Program screen, click Install. The Installing SG-System II 

Console screen displays the progress of the installation.  
15. To complete the installation on the InstallShield Wizard Completed screen, click Finish. 
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Repairing SG-System II Console 
The Windows repair feature allows you to repair the installation of SG-System II Console. 
 
1. Insert the SG-System II Console installation disk in the computer’s CD or DVD drive. 
2. On the Start menu, point to Settings, then point to Control Panel, and then click Add or 

Remove Programs. 
3. On the Add or Remove Programs window, click SG-System II Console. 
4. Click Change. 
5. Click Next. 
6. On the Program Maintenance screen, click Repair. 
7. Click Next. 
8. Click Install. 
9. Click Finish. 
10. Close the Add or Remove Programs window. 
 
 
Removing SG-System II Console 
Removing SG-System II Console uninstalls the entire program, the desktop icon and the Start 
menu directories. Removing the program does not delete the Configuration folder and its 
contents, the unit folders and log files, nor does it delete the file ActivityLog.txt. 
 
Before uninstalling SG-System II Console, the program must be closed. 
 
1. On the Start menu, point to Settings, then point to Control Panel, and then click Add or 

Remove Programs. 
2. On the Add or Remove Programs window, click SG-System II Console. 
3. Click Remove. 
4. On the remove program confirmation message, click Yes. The status screen opens and 

displays the progress of the program’s removal. The screen closes automatically when the 
removal is complete. 
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Opening SG-System II Console 
1. On the Start menu, point to Programs, point to Sur-Gard, point to SG-System II, and then 

click SG-System II Console. 
2. On the Login screen, type the password. 

Note: The OK button will be available once 8 characters have been entered. 
 
For more information on passwords and default passwords, see Changing passwords. 
 
Note: You have three chances to enter the correct password. After the third incorrect attempt, the 
program will close. 
 
Logging in as different user 
A person can log into SG-System II Console as either an Admin or a User depending on the 
specified password. An Admin can configure, set options, and connect SG-System II units, set 
passwords, review system status and logs. A User can connect and disconnect units, view system 
status and logs. Before you can login as a different user, all units must be disconnected from SG-
System II Console. 
 
1. On the File menu, click Login with new password. 
2. Enter the appropriate password. 

Note: The OK button will be available once 8 characters have been entered. 
3. Click OK. 
 
Note: You have three chances to enter the correct password. After the third incorrect attempt, the 
program will close. 
 
Closing SG-System II Console  
Closing SG-System II Console disconnects all units from SG-System II Console, and then closes 
the program. 
 
1. On the File menu, click Exit. 
2. On the confirmation message, click Yes. 
 
Running SG-System II Console 
The operating system installed and the hardware that is connected to the computer running 
SG-System II Console affects the behaviour of SG-System II Console. Be advised of the 
following: 
• When the operating system goes into standby mode, the SG-System II units are forced to 

disconnect. As soon as the operating system resumes, SG-System II Console detects the lost 
connections and automatically attempts to reconnect the units. 

• SG-System II Console cannot be started when another user is running the program in a 
different user session on the same computer. 

• Uploading firmware to the SG-System II requires a direct USB connection from the 
SG-System II to the computer running SG-System II Console. Using an external USB hub 
may interfere with the flashing process and cause the firmware upload to fail 
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Configuring unit section 
Use the top section of the Configuration screen to specify the connection type, name the unit, and 
set passwords unique to the unit. A main password is required to gain general access to the unit. 
A T-Link password is required when an alarm sensor is connected to the unit through TCP/IP. 
 
1. On the SG-System II menu, click Configuration. 
2. Select a connection type. 

Note: Select None when removing a unit. 
3. In the Unit Name box, type a descriptive name that identifies the unit. 
4. In the Main Password box, type a 4-character password using hexadecimal characters (0-9, 

A-F). The password is not case sensitive. The default password is: cafe. 
Note: If password is incorrect SG-System II Console will not be able to connect to the unit for 
status and programming options and a red x will be displayed in the unit’s status section. 

5. In the T-Link Password box, type a 4-character password using hexadecimal characters (0-9, 
A-F). The password is not case sensitive. The default password is: cafe. 

 
Note: This connection type None is selected when the unit is not configured. When none is 
selected, all configuration fields will be disabled. Select this option when removing the unit. 

Configuring Console Interface settings when unit has USB connection 
• From the USB drop-down list select the MAC address for the unit. Ports are not available. 

Configuring Console Interface settings when unit has TCP/IP connection 
The IP address can be found on the front panel of the SG-System II unit. 
 
• In the IP Address box, type the IP address of the unit. As soon as the first digits are entered 

the system generates the port defaults. 
 
Note: To turn off a port, type 0. SG-System II Console will connect to the unit but will not perform 
that command function. 

Resetting TCP/IP details 
Default TCP/IP port settings can be restored if the port settings have been changed or if 
information has been lost. 
 
1. Right-click the unit. 
2. Click Disconnect. 
3. Right-click the unit. 
4. Click Configure. 
5. Click the connection option None. 
6. Click the connection option TCP/IP. 
7. In the IP Address box, type the IP address of the unit. Port information will automatically be 

updated. 
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Configuring e-mail notification 
SG-System II Console can be configured to send an e-mail notification to a specific email 
account when specified events occur.  An e-mail notification will be generated when SG-System 
II Console recognizes one of the following events: 
• Unit is disconnected from SG-System II Console 
• There is a switch from user to administrator role 
• There is a switch from administrator to user role 
• The software closed 
• The software started 
• There is a manual test of e-mail notification 

This procedure outlines the main steps required to complete the E-Mail Notification dialog box. 
For more detailed information, see the procedures that follow. 
 
1. To configure e-mail notification on the Unit Configuration dialog box, under E-Mail 

Notification, click set E-Mail Config. 
2. Set e-mail parameters for host information. 
3. Set e-mail parameter for the sender. 
4. Set e-mail parameter for the recipient. 
5. Type a Subject Base. 
6. To ensure e-mail notification has been set up properly, click Test. 
7. Click OK. 
8. On the Unit Configuration screen, under E-Mail Notification, click the Notification Active 

check box. 
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Setting e-mail parameters for host information 
Host information should be provided by the server administrator. 
 
1. On the Unit Configuration screen, click E-Mail Config. 
2. In the Host Name box, type the name of the SMTP server. 
3. In the User Name box, type the user name. 
4. In the Password box, type the password that is specific to the e-mail account. The password 

will display as asterisks. 
5. In the Port Number box, type the port number. 

Setting e-mail parameters for the sender 
1. Under From, in the Address box, type the sender’s email address. 
2. In the Friendly Name box, type a name that will clearly identify the sender. 

Setting e-mail parameters for the recipient 
1. Under To, in the Address box, type the recipient’s email address. 
2. In the Friendly Name box, type a name that will clearly identify the recipient. 

Setting a subject base for the notification e-mail 
The subject base is the beginning of the email notification’s subject line. That base will be 
followed by text explaining the reason for the notification. 
 
• In the Subject Base box, type words that will identify the content of the email. 

Testing e-mail notification 
Before accepting e-mail parameters, the settings must be tested to ensure the system can contact 
the SMTP server and send a test e-mail to the recipient. When settings must be tested, the 
message Data Needs Testing is displayed with a red background next to the Test button. 
 
1. On the E-Mail Notification dialog box, click Test. A successful test will send an email to the 

specified recipient and display the text Data Tested OK with a green background. 
2. To save settings, click OK. 

Activating e-mail notification 
To have the program send e-mail notification messages for configured units, activate e-mail 
notification. 
 
• On the Unit Configuration screen, under E-Mail Notification, click the Notification Active 

check box. 
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Configuring unit background color 
The Unit Status sections on the SG-System II Console screen can be color coded to match the 
colors of the SG-System II unit display panels for easy identification. 
 
When a unit is selected a darker hue of the color will be displayed in the unit’s status section. 
When a unit is not selected a lighter hue of the color will be displayed in the unit’s status section. 
 
• Click the color to be displayed in the unit section of the Unit Status section. 
 

Configuring logs 
For each unit a set of logs can be created that capture the use, activity and communication 
between the unit and the program. Each log type tracks a particular set of information. 
 

Field  Description 
Command Log Displays all communication between the SG-System II Console to the SG-System II, 

including commands sent to the unit and whether the commands were accepted. 
Audit Log The Audit log is for future use. No messages will appear on this log. 
Printer Log Displays messages detailing unit activity. For example, a failure of the T-Link. 
Upload Log Displays all firmware updates sent to the unit. 
Error Log Displays all communication errors between the SG-System II Console to the SG-

System II. For example, a bad packet is received or a cable is disconnected.  
  
Log files are saved into folders that identify the unit by its original name, such as Unit 1. Folders 
names are not updated to reflect names customized during unit configuration. Within the unit 
folder there are subfolders named according to the log type. By default, logs are saved to: 
• C:\…\Sur-Gard\SG-System II Console\Configuration\ 
 
Log names are system generated. The name identifies the log type and the date and time the log 
was created. The file naming convention is: 
• Log type MMDDYYYHHMMSS.txt 
• For example: 

Printer log 01132006084044.txt 
 
Each log file has a maximum size – the default size is 2048 kilobytes. Once the size limit is 
reached, the log file is closed and a new log file is created.  
 
To access new or current logs, the unit must be disconnected and SG-System II Console must be 
closed. 
 
1. Under Logging, select as many log type check boxes as required. 
2. In the Maximum log file size in kilobytes box, type a new file size, if necessary. 
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Configuring the path to virtual serial port software 
The Path to HW Virtual Serial Port software allows you to connect SG-System II Console to local 
automation and receive signals using virtual serial ports. 
 
Before adding or changing the HW virtual path, disconnect all units. 
 
1. Select the check box Path to HW Virtual Serial Port software. 

Note: If the HW Virtual Serial Port program is not installed on the computer or network, it can 
be downloaded from the HW Group website at www.hw-group.com.

2. In the Path to HW Virtual Serial Port software box type the entire path to the program. 
3. Click OK. 
4. On the File menu, click Exit. 
5. Click Yes. 
6. Open SG-System II Console. 

Configuring USB automation proxy 
Automation software monitors every event on the SG-System II and converts the ASCII text into 
usable information that can be viewed on the SG-System II Console logs. Automation software 
can only connect though TCP/IP or a serial port. When a unit is connected through a USB port, 
USB automation proxy must be configured to create virtual serial ports to connect with the 
automation software. Automation proxy must be configured on the computer that is running SG-
System II Console and is connected to the USB configured unit. 
 
1. Under USB Automation Proxy, click Auto Config. 
2. In the Port box, click the com port you want to connect to. 
3. In the Data Bits box, click the value you want. 
4. In the Stop Bits box, click the value you want. 
5. In the Parity box, click the value you want. 
6. In the Baud Rate box, click the value you want. 
7. In the Virtual Client box, click the virtual client com port. 
8. Click OK. 
 
Note: An alternative solution to USB automation through the SG-System II Console is to use a 
commercial off-the-shelf USB to Serial Converter. In this setup, the SG-System II’s serial port 
should be connected to the converter’s serial connector, and the automation computer’s USB port 
should be connected to the Converter’s USB connector.  

Saving unit configuration 
After updating the settings on the Unit Configuration screen, save the changes. 
 
• To save unit configuration changes, on the Unit Configuration screen, click OK. 
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Changing unit configuration 
Before changing a unit’s configuration, the unit must be disconnected from SG-System II 
Console. 
 
1. On the SG-System II Console screen, under Unit Status right-click the unit you want to 

change. 
2. Click Disconnect. 
3. Right-click the unit’s status section. 
4. Click Configuration. 
5. On the Unit Configuration screen, make changes. 
6. Click OK. 
7. To reconnect the unit, right-click the unit that was just modified, and click Connect. 

Reviewing unit configuration 
Unit configuration can be viewed at any time, regardless of unit connection status. 
 
1. On the SG-System II Console screen, right-click the unit you want to review. 
2. Click the Configuration button. 
3. To close the dialog box, click Cancel. 

Connecting configured units to SG-System II Console 
• To connect SG-System II Console to all configured units, on the SG-System II Console 

screen, click Connect All (  ). 
 
Once the units are connected, the button toggles to Disconnect All (  ). 
Note: The Command tab will display messages when the unit is connected and the time it was 
connected. 
 
The following information will be displayed for each connected unit. 
 
Field  Description 
Unit Name Displays the customized name for the unit. 
Version Displays the firmware version number. 
Status Displays the status of the automation connection: 

• Active means the program is communicating with the automation software. After the 
word active, the port being used for automation will be displayed in parenthesis. 

• Manual means all communication automation is coming from the front panel of the 
unit. 

For more information on status, see the SG-System II user guide. 
USB Address of the USB port to which the unit is connected 
Cmd A green checkmark is displayed when the unit is connected 

A red x is displayed when the: 
• Unit is physically disconnected 
• Unit is connected using the wrong port number 
• Wrong TPC/IP address is selected 
• Wrong USB address is selected 
• Wrong unit passwords are entered in the Configuration dialog box 
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Field  Description 
Audit A green checkmark is displayed when the unit is connected 

A red x is displayed when the:  
• Unit is physically disconnected 
• Wrong TPC/IP address is selected 
• Unit is connected using the wrong port number 
• Wrong USB address is selected 

Print A green checkmark is displayed when the unit is connected 
A red x is displayed when the: 
• Unit is physically disconnected 
• Unit is connected using the wrong port number 

TLink A green checkmark is displayed when the unit is connected 
A red x is displayed when the:  
• Unit is physically disconnected 
• Wrong T-Link password is entered in the Configuration dialog box 
• Unit is connected using the wrong port number 

 

Disconnecting a unit from SG-System II Console 
The unit must be disconnected from SG-System II Console before configuring the unit, 
performing unit maintenance, or if the unit is no longer being used. 
 
1. To disconnect a single unit, on the SG-System II Console screen, right-click the unit you 

want to disconnect. 
2. Click Disconnect unit name. 
 
Note: USB connections can take up to 10 seconds to disconnect. If you try to reconnect too soon 
after disconnecting, an error message will display asking you to try again in a few seconds. 

Disconnecting all units from SG-System II Console 
All units must be disconnected from SG-System II Console before exiting the application and 
shutting down the computer. 
 
• To disconnect all units, on the SG-System II Console screen, click Disconnect All (  ). 
 
Note: USB connections can take up to 10 seconds to disconnect. If you try to reconnect too soon 
after disconnecting, an error message will display asking you to try again in a few seconds. 
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Setting options 
Setting options modifies the firmware options of the selected unit. Virtually all values can be left 
in their default settings. One exception is the IP Address which must be updated.  
 
Option functionality is controlled by the unit. Console options may not match the options 
available on the unit. For more information on setting options, see the SG-System II Console 
manual. 
 
Before setting or changing options, the unit must be connected to the SG-System II Console. 
 
The table below describes the columns displayed on the SG-System II Options dialog box. 
 
Column  Description 
Number  Displays the unit’s option number. 

By default the table is sorted alphanumerically by the Number column 
sequentially by the hexadecimal number. 
To sort by the Name column, click the check box Sort by Name. 

Name Displays a text description of the option that is determined by the unit. 
Default Value Displays the default value for each option.  

Fields in this column cannot be changed.  
Value Displays the actual option selected for the unit.  

If the default value is selected for the option, a box will surround the field. 
Only valid values can be entered, i.e. hexadecimal characters 0-9, A-F. 

Description Describes the option. 
 
1. On the Programming menu, point to SG-System II Options, and then click the unit you 

want to modify. 
2. To change an option, click in the Value field and change the value. 
3. To save changes to the unit, click Set Options.  

Or- 
To cancel changes, click Cancel. If no changes were made, the SG-System II Options dialog 
box closes. If changes were made a confirmation message is displayed: 
• To close the SG-System II Options dialog box without applying changes, click Yes. 
• To keep the SG-System II Options dialog box open without applying the changes, click No. 

4. On the confirmation message, click Done. 
If the unit must be reset for the option changes to be applied, a Reset Required message is 
displayed. On the message, click Yes to proceed with the reset. The system will apply the 
changes, automatically disconnect from the unit, and close the the SG-System II Options 
dialog box.  

5. Click Cancel. 
6. To manually reconnect to the SG-System II unit after it resets, right-click the unit status 

section, and then click Connect Unit Name. 
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Applying current unit options to the Options screen 
The Read Back button reads the actual values set on the unit and applies them to the SG-System 
II Options dialog box. Read back is done automatically on update. This command can also be 
used to cancel any changes that have been made on the Options screen that have not been saved. 
 
1. On the SG-System II Options dialog box, click Read Back.  
2. If changes have been made to the options, a Read Back confirmation message appears. To 

overwrite changes with actual unit options, click Yes. 
3. On the confirmation message Options have been read back from the SG-System II, click 

Done. 

Savings options 
Current options can be saved as a file. The file will be saved in the SG-System II Console folder 
with the extension .sgo. 
 
1. On the Programming menu, point to SG-System II Options, and then click the unit that has 

the options you want to save. 
2. On the SG-System II Options screen, click Save. 
3. On the Save as Options dialog box, in the File Name box, type a descriptive name. 

4. Click Save. 
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Loading options 
A saved options file can be loaded into any unit. This feature can be used to restore a previous 
configuration, or to configure a replacement unit. 
 
Once loaded, you will be prompted to reset the unit. 
 
1. On the Programming menu, point to SG-System II Options, and then click the unit that has 

the options you want to save. 
2. On the SG-System II options dialog box, click Load. 
3. On the Select Options File dialog box, locate and click the file. 

4. Click Open. 
5. Click Set Options. 
6. Click Yes. 
7. If the Reset Required message is displayed, click Yes. 
8. Click Done. 
9. If necessary, right-click the unit, and then click Connect Unit Name. 

Printing unit options 
1. On the Programming menu, point to SG-System II Options, and then click the unit name. 
2. Click Print. 
3. On the Print dialog box, click OK. 

Setting advanced options 
The Advanced Options dialog box provides access to change unit specific options. The changes 
made in this section are not checked for validity. Changing advanced options requires a manual 
reset of the SG-System II. 
 
Warning: This is an advanced feature to be used only with the assistance of Sur-Gard 
Technical support. Before setting advanced options, contact DSC Technical Support. 
 
1. On the Options screen, click Advanced Options. 
2. On the Advanced Options dialog box, in the Enter Option # box, type the bit number of the 

option you want to change. If the bit number is valid, the value will display in the Enter 
HEX Offset box. 

3. In the Value in HEX box, type the new value. 
4. Click Done. 
5. On the SG-System II Options dialog box, click Set Options. 
6. On the SG-System II menu, point to Reset Units, and then click the unit. 
7. On the reset confirmation message, click Yes. 
8. Click Done. 
9. To connect the unit, right-click the unit’s status section, and then click Connect Unit Name. 
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Using the T-Link IP list from the SG-System II 
The T-Link IP List command retrieves the T-Link account list from the SG-System II using port 
3064 (default port). The T-Link account numbers and corresponding T-Link IP addresses are 
displayed in a separate window. The list can be cleared from the window, reloaded or exported to 
a Microsoft Excel spreadsheet. Reloading is not supported in SG-System II version 1.00. 
 
The T-Link IP List command is only available when the selected unit is connected by TCP/IP. 

Reviewing the T-Link IP list 
1. On the Programming menu, point to T-Link IP List, and then click the unit to be reviewed. 
2. To close the dialog box, click Done. 

Rereading the T-Link IP list 
Rereading the T-Link IP list refreshed the list to display the most current information. 
 
1. On the Programming menu, point to T-Link IP List, and then click the unit to be reviewed. 
2. Click Done. 

Clearing the T-Link list 
Clearing the T-Link list clears the list only. The information is not cleared from the unit. 
 
1. On the Programming menu, point to T-Link List, and then click the unit for review. 
2. Click Clear. 
3. Click Done. 
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Using the T-Link IP table from the SG-System II 
The T-Link IP Table command retrieves the T-Link account list which displays all enrolled T-
Links from the SG-System II using port 3064 (default port). The table can be printed or reloaded. 
Reloading is not supported in SG-System II version 1.00. 
 
The T-Link IP Table command is only available when the selected unit is connected by TCP/IP.  
 
The T-Link Table dialog box has two tabs. The Table tab which displays a list of accounts as 
associated details, including the IP address. The Matrix tab provides a graphic display to view the 
status of specific accounts. 

Reviewing the T-Link table 
The table below describes the columns of the T-Link Table tab. 
 
Column  Description 
Account  Displays the account number. 
IP Address Displays the account’s IP address. 
Encryption key Displays the account’s encryption key. 
Supervised Displays No if the account is not supervised, and Yes if the account is 

supervised. 
Present Displays True if the account is sending supervised heartbeats and False if the 

account has stopped sending supervised heartbeats. 
 
1. On the Programming menu, point to T-Link Table, and then click the unit for review. 
2. Click Get T-Link Table. 
3. To close the dialog box, click Done. 

Printing the T-Link Table 
1. On the Programming menu, point to T-Link Table, and then click the appropriate unit. 
2. Click Print. 
3. On the Print dialog box, click OK. 

Saving the T-Link Table 
1. On the Programming menu, point to T-Link Table, and then click the appropriate unit. 
2. Click Save. 
3. In the Save As dialog box, in the File name box, type a descriptive name. 
4. Click Save. 

Loading the T-Link Table 
The Load command is for future use and does not function in this version. 

Clearing the T-Link Table 
Clearing the T-Link table clears the table only. The information is not cleared from the unit. 
 
1. On the Programming menu, point to T-Link Table, and then click the appropriate unit. 
2. Click Clear Table. 
3. On the Clear T-Link Table confirmation message, click Yes. 
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Reviewing the matrix 
The Matrix tab provides a graphic representation of the table. 
 
The following table defines the colors of the matrix blocks. 
 
Color  Definition 
Yellow Account is supervised but has not sent the first signal 
Green Account is okay 
Red Account is supervised but not present. There is no user access 
 
1. On the Programming menu, point to T-Link Table, and then click the unit for review. 
2. Click the Matrix tab. 
3. To view T-Link information for a particular color block, point to the color block. Details are 

displayed in the right column. 
4. Click Done. 
 
Viewing version information for a connected unit 
When viewing version information for a connected unit, the following information is displayed: 
• MAC Address – when the unit is connected by USB 
• IP Address – when the unit is connected by TCP/IP 
• WAN Address – TCP/IP address used to connect to all alarm units 
• WAN Port – TCP/IP port used to communicate with the alarm port 
• Firmware Version – version installed on the unit 
 
1. To view version information, on the Programming menu, point to Version Info, and then 

click the unit. 
2. Click Done. 
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Updating firmware 
Before updating the firmware: 
• Ensure no other processes are running on the computer, including but not limited to: 

• Virus software 
• File uploads 
• Internet browser(s) 
• Print spoolers 

• Ensure the unit remains powered on and connected. 
 

Warning: Uploading firmware to the SG-System II requires a direct USB connection 
from the SG-System II to the computer running SG-System II Console. Using an external 
USB hub may interfere with the flashing process and cause the firmware upload to fail. 
 
1. To update firmware, on the SG-System II menu, point to Code Upload, and then click the 

unit to be updated. 
2. On the SG-System II Code Upload dialog box, under File to Upload, click the browse 

button. 
3. Locate and select the file. 
4. Click Open. 
5. Click Upload. The unit will reset automatically once the upload is complete. 
6. On the information box, click Done. 
7. Click Done. 
 
Note: If the unit has been configured to log uploads, the firmware update will be logged. 
 
Setting the date and time 
The date and time is sent from the SG-System II Console to the SG-System II on the hour every 
hour when connected. The Set Date/Time command allows you to update the SG-System II as 
needed. 
 
1. On the SG-System II menu, point to Set Date/Time, and then click the unit to be updated. 
2. On the confirmation message, click Done. 
 
Note: If the unit has been configured to log Commands, this change will be logged. 
 
Printer Test 
This feature is used to verify the SG-System II unit is communicating with the SG-System II 
Console software. The status will appear on the Unit Status screen’s Printer tab and will print to 
any connected printer. 
 
• On the SG-System II menu, point to Printer Test, and then click the unit to be tested.  
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Reviewing SG-System II Status 
The Unit-System Status screen is a read-only window that displays the selected unit’s connection 
status and the status and/or mask information for its power supply, automation and printer setup. 
The screen refreshes every 15 seconds to display the most current information. For more 
information, see the SG-System II manual. 
 
Multiple SG-System II Status windows can be displayed at the same time for multiple units. 

1. On the SG-System II menu, point to SG-System II Status, and then click the unit to be 
reviewed. 

2. Review the details. 
3. Click Close. 

Moving the Unit-System Status window behind the SG-System II Console 
window 
1. On the SG-System II menu, point to SG-System II Status, and then click the unit to be 

reviewed. 
2. Review the details. 
3. Click Hide. A name button will appear on the Windows Taskbar. 
 
Resetting the SG Fallback 
By default automation is connected through TCP/IP. If the TCP/IP connection fails, automation 
connects though the USB. If the USB connection fails, automation connects through the serial 
port. If the serial port connection fails, automation switches to manual mode where all alarms are 
acknowledged on the unit. A unit’s current automation connection is displayed on the SG-System 
II Console screen, in the unit’s Status field. 
 
Resetting the SG Fallback resets the fallback mode of the SG-System II unit to TCP/IP – the 
beginning of the list. – so that the system can follow the automation connection process as 
necessary. Fallbacks generate a Printer log message. 
 
• On the SG-System II menu, point to Reset SG Fallback, and then click the unit to be reset.  
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Resetting the unit 
A unit may need to be reset in order to apply certain options, such as a change to the IP address or 
when instructed by DSC Technical Support. Resetting a unit will reboot the SG-System II within 
30 seconds of receiving the command. 
 
1. On the SG-System II menu, point to Reset Units, and then click the unit to be reset. 
2. On the confirmation message, click Yes. The unit will power off and then power on. 
3. On the manual reset message, click Done. 
4. Reconnect the unit. 
 
Changing passwords 
Two types of users can log into SG-System II Console, Admin and User. An Admin can 
configure units, set passwords, set options and connect/disconnect units. A User is able to view 
unit status and connect/disconnect units. 
 
The login password entered defines the type of user logged in and the permissions assigned to 
that user. 
 
Passwords are case sensitive and must be a minimum of 8 characters. 
 
Note: If you cannot find the current passwords you must reinstall SG-System II Console. 

Default login passwords 
When the SG-System II Console is first installed the default login passwords are: 
 
Type Default password 
Login Admin adminpass 
Login User userpass 
 
Changing the Admin Password 
1. On the File menu, click Change Admin Password. 
2. In the New Password field, type a password. 
3. In the New password re-entered for verification field, type the same password. 
4. Click OK. 
 
Note: The default admin password is: adminpass 

Changing the User Password 
1. On the File menu, click Change User Password. 
2. In the New Password field, type a password. 
3. In the New password re-entered for verification field, type the same password. 
4. Click OK. 
 
Note: The default user password is: userpass 
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Working with logs 

Clearing a log 
Clearing a log removes all text from the active log. It does not affect the log file. 
 
1. Click the log tab to be cleared. 
2. Right-click the log window, and then click Clear Current Log. 

Copying text from a log 
Copying text from a log allows you to paste the messages into another program. 
 
1. Click the log tab. 
2. Select the text to be copied. 
3. Right-click the log window, and then click Copy Selection to Clipboard. 

Selecting all of the text in a log 
Selecting all of the text in a log file selects all of the text in the window including text that is not 
visible. Once text is selected it can be copied and pasted into another application. 
 
1. Click the log tab. 
2. Right-click the log window, and then click Select all Text.  

Clearing all the text of all log windows 
Clearing all of the text in all log windows removes text for the selected unit only. 
 
1. Click the log tab. 
2. Right-click the log window, and then click Clear All Log Windows. 

Displaying the last message on top 
The Last Message of Top feature automatically displays the log tab that has most recently 
received a message from the selected SG-System II unit. 
 
• Right-click the log window, and then click Last Command on Top. 
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Customizing label, command and button text 
The command labels and screen buttons can be customized or changed to any language.  
 
The language file is located in: 
• C:\…\Sur-Gard\SG-System II Console\English.lan 

About the language file 
• The file groups together similar elements. For example, all buttons are listed under the 

heading Button Captions. 
• Each line has three fields separated by a bar: 

• The first field is the index number of the language element and must never be changed 
• The second field is a comment that describes the element, and is often the same text as 

the English label. The comment is always in parentheses. 
• The third field contains the text that will be displayed in the program. 

• Strings containing %s or %d are format strings. You must retain the correct number of %s 
and %d references in the translated string, and they must be in the same order. 

• \n denotes a hard line return which can be used for multi-line translations. 
• All information for an item must be on the same line. Therefore, when entering long lines of 

text do not press the Enter key. Instead let the text wrap to the next line. If button text is too 
long it will be truncated. 

• ASCII text can be used to insert accented and special characters. 
• An ampersand (&) before a letter will underline that letter in the program so that it can be 

used as a keyboard command. For example, &Cancel will appear as Cancel. Pressing Alt+C 
will cancel changes. 

• If you do not want text to appear, leave the third field blank. Do not delete an entire line. 
 

Changing the language file 
Before changing the language file, ensure that SG-System II Console is closed.   
 
Note: You can open and edit the language and configuration files using Microsoft Notepad or 
Microsoft WordPad. 
 
1. From the directory C:\ …\Sur-Gard\SG-System II Console, open English.lan. 
2. From the Format window, ensure that Word Wrap is turned off. 
3. Make all changes. 
4. On the File menu, click Save As. 
5. In the default folder, type a file name with the extension .lan. 
6. Click Save. 
7. Close the language file. 
8. From the directory C:\…\Sur-Gard\SG-System II Console\Configuration, open the file 

Console.ini. 
9. On the second line of the file, Language=English, replace the word English with the name of 

the language file you created. Omit the extension. 
10. On the File menu, click Save. 
11. Close the Console.ini file. 
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Getting help 
• On the Help menu, click SG-System II Help. 
 
Note: To display the SG-System II Console user guide, the computer must have Adobe Acrobat 
installed. 
 
Getting information about SG-System II Console 
The About screen displays details about the version of SG-System II Console installed, contact 
information to DSC and links to the DSC website and a technical support e-mail address. 
 
• On the Help menu, click About. 
 
Contacting DSC 
You can easily contact DSC Technical Support by phone or fax. You can also send DSC 
Technical Support your comments or questions e-mail.  
 
To assist with diagnosis, SG-System Console II can collect copies of unit log files from the last 
24 hours. The files are copied to a new folder on the desktop named SurGard_DDMMYYYY. 
These files can then be compressed and attached to the e-mail. The instructions below explain 
how to send an e-mail with unit log files. 
 
1. On the SG-System II Console screen, click the Tech Support button (  ). 
2. On the confirmation message: 

• If units that require support are connected, click OK. 
• If units that require support need to be connected, click Cancel. 

3. On the Log File Selection dialog box, click the check box next to the appropriate unit or 
units. 

4. Click OK. 
5. On the e-mail message click Insert. 

Note: The button may be labelled Attach depending on the e-mail program used. 
6. Locate and select the appropriate dated SurGard folder on the desktop. 

Note: The folder will follow the naming convention - SurGard_<MMDDYYYY>.  
7. Compress the folder. 
8. From the list, select the compressed dated SurGard folder, and click Insert. 
9. Type the message and then click Send. 
10. To reconnect units that were disconnected when the log files were created, click 

Connect All (  ). 
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